Welcome

Thank you for purchasing H.264 Pro Recorder. Now you can easily convert your videos to H.264 in real time for the web, iPhone, iPad, Apple TV, YouTube and more!

Previously, H.264 encoding was either a very slow software process or required fast, expensive computer hardware. H.264 Pro Recorder has a built-in high quality H.264 hardware-encoding engine and image processor so you get amazing quality H.264 video in real time.

H.264 Pro Recorder produces stunning quality digital video from the highest quality SDI, HDMI and component analog video as well as regular composite analog video. It can even work with S-Video via a third party S-Video breakout cable (not included) and supports 2 channels of professional balanced audio input. With all these connections supported, you can encode from practically any device out there. It even has an RS-422 remote control port so you can batch capture H.264 video from your decks just as you would with normal video!

We think it should take you approximately 5 minutes to complete the installation. Before you install H.264 Pro Recorder, please check our website at www.blackmagicdesign.com/support and click the support page to download the latest updates to this manual and H.264 Pro Recorder software.

Lastly, please register your H.264 Pro Recorder when downloading software updates. We would love to keep you updated on new software updates and new features for your H.264 Pro Recorder. We are constantly working on new features and improvements, so we would love to hear your suggestions for improvements to the software!

Grant Petty
CEO Blackmagic Design
## Contents

**H.264 Pro Recorder**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>4</td>
</tr>
<tr>
<td>Blackmagic H.264 Pro Recorder</td>
<td>4</td>
</tr>
<tr>
<td>Your Computer’s System Requirements</td>
<td>4</td>
</tr>
<tr>
<td>How to Install Your Blackmagic Video Hardware</td>
<td>4</td>
</tr>
<tr>
<td>Install the Blackmagic Design Software</td>
<td>5</td>
</tr>
<tr>
<td>Installing Blackmagic Desktop Video</td>
<td>5</td>
</tr>
<tr>
<td>Blackmagic Media Express</td>
<td>7</td>
</tr>
<tr>
<td>What is Media Express?</td>
<td>7</td>
</tr>
<tr>
<td>Capturing Video and Audio Files</td>
<td>8</td>
</tr>
<tr>
<td>Playing Back Video and Audio Files</td>
<td>12</td>
</tr>
<tr>
<td>Browsing Media</td>
<td>14</td>
</tr>
<tr>
<td>Help</td>
<td>16</td>
</tr>
<tr>
<td>Which Connections Should I Use for Best Quality Video?</td>
<td>16</td>
</tr>
<tr>
<td>Consumer Level Analog Audio Signals</td>
<td>17</td>
</tr>
<tr>
<td>RS-422 Remote Device Control</td>
<td>17</td>
</tr>
<tr>
<td>Getting Help</td>
<td>18</td>
</tr>
<tr>
<td>Connection Reference Guide</td>
<td>19</td>
</tr>
<tr>
<td>Warranty</td>
<td>23</td>
</tr>
</tbody>
</table>
Getting Started

Blackmagic H.264 Pro Recorder

Your Computer’s System Requirements

H.264 Pro Recorder does the hard work of encoding uncompressed video into the H.264 format so you only need a modest computer to capture the encoded MP4 files.

You will need to provide a USB 2.0 type A to mini B male cable to connect H.264 Pro Recorder to your computer.

All platforms require the installation of Blackmagic Desktop Video software to configure and control your H.264 Pro Recorder. Your computer will need 4GB of RAM and a dedicated USB 2.0 port to capture video.

Mac OS

Desktop Video software runs on the latest Yosemite and El Capitan versions of Mac OS.

An Intel-based Mac computer is required.

Windows

Desktop Video software runs exclusively on 64-bit versions of Windows 7, 8 and 10 with the latest service pack installed.

The latest version of Apple QuickTime for Windows is required to open the MP4 movie files.

How to Install Your Blackmagic Video Hardware

1. Connect the included external power supply to the H.264 Pro Recorder and switch on the power.

2. Connect a USB 2.0 type A to mini B male cable between the H.264 Pro Recorder and a dedicated USB 2.0 port on your computer.

3. If Desktop Video software has previously been installed and offers to update the internal software, click Update and follow any onscreen instructions.
Install the Blackmagic Design Software

After installing your hardware, the next step is to install the Blackmagic Design Desktop Video software. Please jump to the installation instructions for Mac OS or Windows in this section.

Installing Blackmagic Desktop Video

Mac OS Installation
Make sure you have administrator privileges before installing any software.

1. Ensure you have the very latest driver. Visit [www.blackmagicdesign.com/support](http://www.blackmagicdesign.com/support)
2. Launch the Desktop Video Installer from the media included with your hardware or from a downloaded disk image.
3. Click the ‘continue’, ‘agree’ and ‘install’ buttons to install the software.
4. Restart your computer to enable the new software drivers.

![Desktop Video Installer for Mac](image)

Automatic Updates
When your Mac restarts the software will check the internal software version of your hardware. If the internal software version does not match the driver version, you will be prompted to update the internal software. Click OK to start the update and restart your Mac to complete the process.

Windows Installation

1. Ensure you have the very latest driver. Visit [www.blackmagicdesign.com/support](http://www.blackmagicdesign.com/support)
2. Open the “Desktop Video” folder and launch the “Desktop Video” installer.
3. The drivers will now be installed on your system. An alert will appear: “Do you want to allow the following program to install software on this computer?” Click ‘yes’ to continue.
4. You will see a dialog bubble saying “found new hardware” and the hardware wizard will appear. Select “install automatically” and the system will find the required Desktop Video drivers. Another dialog bubble will appear saying “your new hardware is ready for use.”
5 Restart your computer to enable the new software drivers.

Desktop Video Installer for Windows

**Automatic Updates**

When your computer restarts the software will check the internal software version of your hardware. If the internal software version does not match the driver version, you will be prompted to update the internal software. Click OK to start the update and restart your computer to complete the process.
Blackmagic Media Express

What is Media Express?

Blackmagic Media Express is a sophisticated software application which enables H.264 Pro Recorder users to capture video and audio to industry standard MP4 files with frame accurate RS-422 device control. It automatically detects whether the video source is HD1080, HD720, NTSC or PAL and also automatically detects the frame rate. Capture from progressive and interlaced video sources is supported and the captured file is stored in a progressive format for maximum compatibility with media player software on Mac OS, Windows and portable video players.

Media Express 3 also supports CMX EDL import and frame accurate deck control via RS-422! Media Express is fast, accurate and easy to use. You can even grab still frames directly from your deck and save them as still images. That’s a complete solution for capture and playback!

Blackmagic Media Express 3 is a great tool when you don’t need the complexity of NLE software but simply want to capture old or new programming content into the same file format used on the web, iPad™, iPod™, iPhone™, Apple TV™, YouTube™ and more.

The User Interface

Media Express can easily be scaled for different sizes of monitors or even small notebook screens. When you open Media Express, you’ll notice the log and capture, playback and edit to tape views are color-coded so you will know at a glance which mode is being used. The edit to tape view is not used by H.264 Pro Recorder but may be used with other Blackmagic Design capture and playback products.

Media List

The left "media list" always displays the scratch, any bins you have created and also any media you have imported, captured or logged for capture. Media can be displayed in Timecode List view or Thumbnail view and you can even filter media by favorites. The Search field makes it easy to find media by name or by attributes captured in the media metadata. The project name and format are shown in the bottom-left corner of the Media Express window.

The top-right pane always displays the video preview. Timecode is displayed at the top of the video preview pane and NO REMOTE will be indicated if no RS-422 device control is connected.

Log and Capture

Click on the red Log and Capture tab. The video preview pane shows the source video from your camera or deck. Here you can enter metadata for the clips you will capture including name, description, reel number, favorite and more. You can capture with or without device control, log clips with in and out points, and batch capture. Double-clicking a captured clip in the media list will automatically switch Media Express to Playback view.
Playback
In the green Playback view, the video preview pane shows the video of the clip being played. Click the favorites button to add to your favorites in the media list.

Edit to Tape
The edit to tape view is not used by H.264 Pro Recorder but may be used with other Blackmagic Design capture and playback products.

Capturing Video and Audio Files

Selecting H.264 Pro Recorder
If you have more than one Blackmagic Design capture product installed or connected to your computer, go to the Device menu in Media Express and select H.264 Pro Recorder. In the example pictured on this page, a DeckLink card and a H.264 Pro Recorder are both installed in the same computer. Selecting H.264 Pro Recorder will allow you to choose suitable H.264 settings for your project.

Select H.264 Pro Recorder from the Device menu.

Setting Up a Project
Before capturing any clips in Media Express, you will need to select the settings for your project. Go to Media Express>Preferences on Mac OS or Edit>Preferences on Windows. Any settings which are grayed out are only used with other Blackmagic Design capture products and are not required by H.264 Pro Recorder.
The Project Video Format defines the frame size of the current H.264 project. Choose “Native (Progressive)” for full resolution encoding of your video or select from a number of popular device presets including iPad and YouTube. H.264 Pro Recorder automatically detects the frame rate of your video.

Video formats are provided for popular devices as well as full resolution, Native (Progressive) video.

The Capture File Format always sets the video codec to H.264, and the file format to MP4, when using H.264 Pro Recorder. Other choices appear in this menu when using other Blackmagic Design capture products.

The Quality button provides access to the H.264 encoding settings and is only available when H.264 Pro Recorder has detected a valid video input signal. We recommend leaving the maximum bit rate unchanged from the default setting.

Set the storage location for your captured video and audio and choose whether to stop capture or playback if dropped frames are detected.

Standard definition projects are set to the 4:3 aspect ratio unless you enable the Anamorphic SD 16:9 checkbox.

Usually video applications stop playing video if you send them to the background. If you want Media Express to keep playing video through your Blackmagic video hardware, even if you open another application in the foreground, enable the checkbox to “Continue playback when in the background”.

The final options relate to tape decks with RS-422 deck control.

Your tape deck requires a pre-roll of a few seconds before performing an edit so the tape speed is stable by the time it is used for an edit.

Timecode offsets can also be set to calibrate the timecode to the video.
Capturing video is easy and all you need to do is connect a video source, set the Media Express preferences and press the Capture button. Video will be encoded in the H.264 format and saved to an MP4 file.

Start by connecting your video source to an input of your H.264 Pro Recorder. Only connect one video source to H.264 Pro Recorder so that it can auto-detect which source to use, e.g. SDI, HDMI, component, S-Video or composite analog video.

Open Media Express and set its preferences to the desired project video format.

Click the red Log and Capture tab and enter a description for your video into the Description field of the logging information area.

Enter a description for your video.
Click the "+" button next to the Description to add it to the automatic Name field. Click the "+" button next to any of the other fields that you wish to add to the Name field.

- You can increment the value in each of these fields by clicking on the corresponding clapper board icon. Alternatively you can type directly in to any field to customize its name and number.
- The text in the automatic Name field will be applied to the clip(s) which are about to be captured.
- Click the "star" icon next to the Name field if you want to log the clip as a favorite.
- Click the "!" icon next to the Name field if you wish a clip name confirmation prompt to appear before every capture. This will provide you with the chance to change the clip name.

Set which two audio channels are to be captured and then click the "Capture" button to start recording.

Set the desired audio channels to be captured.

To end capture, click the "Capture" button again to automatically keep the clip. Alternatively press the "Esc" key if you want to be prompted to delete or save the clip.

Click the "Capture" button to commence recording.

The captured clips will be added to the Media List.

**Logging Clips**

Ensure an RS-422 serial cable is connected between your H.264 Pro Recorder and the deck. The Remote/Local switch must be set to Remote on the deck so you can use the transport controls in Media Express. Use the standard j, k, l shortcut keys to shuttle backwards, pause and shuttle forwards on the deck.

Click the Mark In button to mark the In point, or use the shortcut key i.

Click the Mark Out button to mark the Out point, or use the shortcut key o.

Click the Log Clip button to log the clip, or use the shortcut key p. The entry should now appear in the Media List with a red X in its icon to indicate the media is offline.
**Batch Capture**

After logging a clip, you can click the Clip button if you just want to capture a single clip.

If you want to capture multiple clips, continue logging all the clips that you wish to batch capture.

When logging is completed, select the logged clips in the Media List and:

- click the Batch button, or
- right-click on the selection and select 'Batch Capture', or
- go to the File menu and choose Batch Capture.

Media Express will cue the tape and precisely capture the clip from the In to the Out timecode points, including any handles specified in the Media Express preferences.

---

**Playing Back Video and Audio Files**

**Importing Clips**

You can play back your video and audio files after capturing video or importing media in to Media Express in any of the following ways:

- Double-click an empty area of the Media List.
- Right-click an empty area of the Media List and select Import Clip from the contextual menu.
- Go to the File menu, select Import and then Media Files.

Then select the MP4 clip(s) you wish to import from the Open Video Clip dialog box. The clips will appear in the Scratch area of the Media List. If you have created your own bins in the Media List, you can drag the clips in to the desired bin.
There are three ways to import clips into Media Express.

If you want to import media directly to a bin, right-click within the desired bin and select Import Clip from the contextual menu.

If the files being imported do not match the frame rate and size of existing clips in the Media List, you will be prompted to create a new project and to save the current project.

Another way to import media is to use an XML file which has been exported from Final Cut Pro 7. Go to the File menu, select Import and then Final Cut Pro XML. Open the desired XML and all the bins and media from the Final Cut Pro project will appear in the Media List.

Media Express also supports the import of CMX EDL files to batch capture clips using EDL files from other video software. Go to the File menu, select Import and then CMX EDL. Select the EDL and open it. The logging information will appear in the Media List. Select the logged clips and perform a batch capture to import the clips from your deck.

Playing Back Single and Multiple Clips

You can play back H.264 files in the video preview pane of Media Express, and monitor audio via the default sound output of your computer. Alternatively QuickTime Player, iTunes, Windows Media Player and VLC can all be used to play back your H.264 files in full screen.

To play back a single clip, double-click the clip in the Media List. Alternatively select the clip in the Media List and press the space bar on your keyboard or the play button in the transport controls.

To play back multiple clips, select the clips in the Media List and then press the space bar on your keyboard or the play button in the transport controls.

Your video will play back in the video preview pane of Media Express. During playback, the audio channels being monitored can be switched on or off via the track enable/disable buttons.

You can use the transport controls to play, stop, jump to the next or previous clip and loop playback of your clips.
Browsing Media

In the Media List, you can view your clips in Thumbnail view or Timecode List view by clicking on the desired view button at the top-right of the Media List.

Thumbnails are the most intuitive way to display your clips. To get information for a clip, hover your mouse over the clip’s thumbnail and then click on the popup info icon which will appear at the bottom-right of the thumbnail. Click the info bubble to hide it.

You can view your clips in Timecode List view by clicking on the Timecode List button at the top-right of the Media List. Use the horizontal scroll bar at the bottom of the Media List to view all the columns of information for your clips including: in and out points, video format, audio channels, field dominance and logging information.

Creating and Using Bins

To create a bin for your clips, right click an empty spot in the Media List and select “Create Bin”. Type in a name for the new bin.

You can move clips from the Scratch, or from one bin to another, by dragging the clip icons to the desired bin. If you want a clip to appear in more than one bin, import the same clip again by right-clicking on the bin and choosing “Import Clip”.

By default, logged clips appear in the Scratch. If you want to log clips and have them appear in a new bin, right-click the new bin and choose “Select As Log Bin”.

List View

You can view your clips in Timecode List view by clicking on the Timecode List button at the top-right of the Media List. Use the horizontal scroll bar at the bottom of the Media List to view all the columns of information for your clips including: in and out points, video format, audio channels, field dominance and logging information.
Creating and Using Favorites

In the Log and Capture tab, click the "star" icon next to the Name field if you want to log a clip as a favorite.

In the Playback tab, clicking the "star" icon will make the clip a favorite if it is selected in the Media List. Click the "star" icon again to deselect it as a favorite.

Clips marked as favorites will show a yellow star in their icon in Timecode List view and Thumbnail view.

Once you have marked clips as favorites, click on the gray, Favorites, star button at the top of the Media list and it will turn yellow. All clips in your Media List will be hidden except for those marked as favorites. This is similar to creating a playlist and makes it easy to only play back your favorite clips.

Deleting Clips and Bins

To delete clips, select the unwanted clips and press the forward delete button on your keyboard. This will only delete the clips from the Media List and they will safely remain on your disk storage.

To delete bins, right-click within a bin and choose "Delete Bin". This action will delete the bin and any clips it contained. This will only delete the clips from the Media List and they will safely remain on your disk storage.

Searching the Media List

Clips can easily be found in a project by typing the name of your clips in the Search field at the top of the Media List. When used in conjunction with the favorites feature, the search will be confined to your favorite clips so you will see a shorter list of found clips.
Which Connections Should I Use for Best Quality Video?

Choosing the best video connections to use with cameras, decks, capture cards and other video equipment can be confusing but it’s easy with H.264 Pro Recorder. Simply choose the best quality uncompressed output connection provided by each piece of video hardware. For example, H.264 Pro Recorder can capture composite analog video, from an old field deck, but can also capture HDMI from the latest DSLR cameras and even HD-SDI digital video and audio from an ARRI ALEXA camera or HDCAM SR deck.

If you are capturing from analog video equipment, you will also need to connect the left and right analog audio cables in addition to any video cables. By contrast, HDMI and SDI digital connections only need a single cable to carry both digital video and digital audio.

Composite — Good Analog Video

Composite is the oldest and most common analog video format and is often regarded as “regular video”. You are likely to find it on almost any video device. Broadcast and professional video equipment will usually have a single BNC connector for composite video whereas consumer equipment will usually use a single, yellow RCA connector. An inexpensive BNC-RCA adapter can be used to connect composite video from consumer equipment to the BNC connector on H.264 Pro Recorder.

S-Video — Better Analog Video

S-Video is higher quality than composite video and became a mainstream consumer standard in the late 1990s. It can also be found on some professional video hardware. Professional video equipment will sometimes have dual BNC connectors for S-Video labelled “Y” and “C”, whereas consumer equipment will use a single, multi-pin S-Video connector.

- “Y” and “C” ports connect directly to the S-Video Y and S-Video C ports on H.264 Pro Recorder using BNC cables.
- When connecting a multi-pin S-Video port to H.264 Pro Recorder, an inexpensive third party, breakout cable (not included) is required. The breakout cable adapts a single, S-Video connector to two BNC connectors on the H.264 Pro Recorder.

Component — Best Analog Video

Component is the highest quality analog video connection. It appeared on broadcast and professional video equipment during the 1990s and finally became popular on consumer equipment during the 2000s. It uses three cables to transmit all of the color information. On broadcast and professional video equipment, BNC connections are usually used. On consumer equipment, RCA connectors are used on three cables which are usually colored red, green and blue. Inexpensive BNC-RCA adapters can be used to connect component video from consumer equipment to the three BNC connectors on H.264 Pro Recorder.

HDMI and SDI — Digital Video is the Best!

HDMI and SDI are digital protocols which provide the highest quality video to H.264 Pro Recorder. A single cable is used to transmit all of the color and audio information.

If you have a choice of using analog or digital connections, always choose digital for the best quality video and audio.
HDMI provides the same uncompressed, digital quality as high-end SDI digital video but at a much lower cost. It is designed to be used over short distances and standard cables are typically only 6 feet or 2 meters in length. HDMI is often found on consumer equipment as well as on some professional equipment. The HDMI cable can be directly connected to the HDMI port on H.264 Pro Recorder.

SDI and HD-SDI provide industrial grade connections for uncompressed, digital video. SDI cables support transmission of uncompressed digital video over at least 300 feet or 100 meters. SDI and HD-SDI connections are found on high-end broadcast and professional video hardware. An SDI or HD-SDI cable can be directly connected the SDI / HD-SDI port on H.264 Pro Recorder.

**How Does H.264 Pro Recorder Know Which Input Connections to Use?**

H.264 Pro Recorder auto-detects the video input you wish to use, i.e. SDI, HDMI, component, S-Video or composite analog video. For this reason, only connect one video source to H.264 Pro Recorder so it can auto-detect which source to use. If you are using analog video, you can also connect analog audio at the same time as expected. The RS-422 remote connection does not affect video input auto-detection.

**Consumer Level Analog Audio Signals**

**Can I Use H.264 Pro Recorder with Consumer Level Analog Audio Signals?**

Yes and no! H.264 Pro Recorder is designed to work with professional, balanced, analog audio equipment. It does not work directly with unbalanced, consumer level analog audio. In order to capture unbalanced audio from consumer equipment, a third party balancing transformer with line level converter can be used.

It is not necessary to buy an expensive balancing transformer. Low cost models exist and do a great job and typically cost around US$65.

**RS-422 Remote Device Control**

H.264 Pro Recorder features an industry standard, Sony™ compatible, RS-422 deck control port which has the correct pin connections for a direct connection to any deck.

You can use pre-manufactured 9 pin cables as long as each end of the cable are wired “pin for pin” where the same pin number on each end of the cable are connected together. If you would like to make custom cables, e.g. for extra length, please refer to the accompanying wiring diagram.
Getting Help

There are four steps to getting help.

1. Check out the Blackmagic Design web site www.blackmagicdesign.com and click on the “Support” page for the latest support information.

2. Call your dealer.

   Your dealer will have the latest technical updates from Blackmagic Design and should be able to give you immediate assistance. We also recommend you check out the support options your dealer offers as they can arrange various support plans based on your workflow requirements.

3. The next option is to email us with your questions using the web form at www.blackmagicdesign.com/support

4. Phone a Blackmagic Design support office. Check our website for current support phone numbers in your area. www.blackmagicdesign.com/company

Please provide us with as much information as possible regarding your technical problem and system specifications so that we may try to respond to your problem as quickly as possible.
Connection Reference Guide

Component Analog Video Connections

H.264 Pro Recorder’s analog video BNC connectors can be used for component analog video capture, in high definition or standard definition.

S-Video Analog Connections

H.264 Pro Recorder’s analog video BNC connectors can be used for S-Video analog video capture in standard definition. While some analog decks provide S-Video Y and C ports using two BNC connectors, other analog equipment uses a single S-Video connector. A simple S-Video to dual BNC adapter cable (not included) can be used for S-Video capture as illustrated below.
Composite Analog Video Connection

H.264 Pro Recorder’s analog video BNC connectors can be used for NTSC/PAL capture in standard definition.

Betacam SP Analog Deck

This example shows H.264 Pro Recorder connected to an analog deck for component analog video and audio capture from the deck.
SDI Digital Deck
This example shows H.264 Pro Recorder connected to a standard definition digital deck for capture from the SDI deck.

Sony HDCAM SR Deck in 4:2:2
This example shows H.264 Pro Recorder connected to a Sony HDCAM SR™ series digital deck in YUV 4:2:2 HD mode for capture from the HD-SDI deck.
HDMI Camera

H.264 Pro Recorder captures video in real-time directly from the HDMI output of still cameras and video cameras, including AVCHD and HDV cameras.

If you have an older camera without HDMI, use the best quality analog video output connections provided by the camera and connect to the corresponding analog video input connections on H.264 Pro Recorder. You will also need to connect analog audio.
Warranty

12 Month Limited Warranty

Blackmagic Design warrants that this product will be free from defects in materials and workmanship for a period of 12 months from the date of purchase. If a product proves to be defective during this warranty period, Blackmagic Design, at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the defect before the expiration of the warranty period and make suitable arrangements for the performance of service. The Customer shall be responsible for packaging and shipping the defective product to a designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer shall be responsible for paying all shipping charges, insurance, duties, taxes, and any other charges for products returned to us for any reason.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under this warranty: a) to repair damage resulting from attempts by personnel other than Blackmagic Design representatives to install, repair or service the product, b) to repair damage resulting from improper use or connection to incompatible equipment, c) to repair any damage or malfunction caused by the use of non Blackmagic Design parts or supplies, or d) to service a product that has been modified or integrated with other products when the effect of such a modification or integration increases the time or difficulty of servicing the product. THIS WARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. BLACKMAGIC DESIGN’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER BLACKMAGIC DESIGN OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BLACKMAGIC DESIGN IS NOT LIABLE FOR ANY DAMAGES RESULTING FROM USE OF THIS PRODUCT. USER OPERATES THIS PRODUCT AT OWN RISK.

© Copyright 2019 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’, ‘Videohub’, ‘DeckLink’, ‘Intensity’ and ‘Leading the creative video revolution’ are registered trademarks in the US and other countries. All other company and product names may be trade marks of their respective companies with which they are associated.